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FOUNDED MAY 1989 

MEETINGS - SECOND  

  SATURDAY OF THE MONTHSOME WEBSITES 

How to Take Better Photos in 
Your Home (No Flash Needed) 
Great ideas from How-To Geek 
for indoor photography. bit.ly/
3gj8VbV.

How to Transfer Apps from 
iPad to iPhone in a Batch. 
Three different methods to do it 
in just a matter of minutes. 
bit.ly/39KwQOQ.

How to Change App, File, and 
Folder Icons on a Mac. Keep 
things interesting. Try changing 
the icons of your favorite apps, 
f i les , and fo lders . b i t . ly /
30gDmd5.

Apple details an impressive, 
aggressive transition to Macs 
with its own processors. But 
it’s your guess as to how fast. 
bit.ly/2DmU2qs.

With Apple Silicon on the 
horizon, should you buy a 
Mac right now, or wait? 
CNN’s suggestion is don't wait 
for Apple Silicon Macs to 
become avai lable. cnn. i t /
3hTXYOd. 

JULY & AUGUST  - WE’RE ON VACATION 

NO MEETINGS - BUT KEEP READING 

FOCUS - APPLE AND SOFTWARE 
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https://bit.ly/3gj8VbV
https://bit.ly/39KwQOQ
https://bit.ly/30gDmd5
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Membership Information 
Membership dues are $30 for individuals and $40 for 
families. Memberships are based on your anniversary 

date, which is the month you joined. You will be e-
mailed reminders when membership fee is due.  
If you’re just visiting to check us out, or if you’ve 
been visiting for some time, but haven’t joined, 
consider these BENEFITS OF MEMBERSHIP:


• Monthly meetings, where you can learn, share, 
and meet everyone from working Mac 

professionals to new Mac users from all 
backgrounds.


• Monthly newsletter, which is full of interesting 
Mac news, tips, and information.


• Useful free items at the monthly Raffles. 

• Discounts. Vendors offer special prices to User 

Group members.

• Web Site with 2-3 years of MLMUG 

newsletters, meeting information, a member 
directory, directions to our meetings, and much 

more! Our web site is www.mlmug.org.

• MLMUG Mailing List, to post technical 

questions or comments to each other and the 
experts within the group. 


• Reviewers keep items reviewed.

Are you ready to join? Please make a check 
payable to MLMUG and bring it to a monthly 

meeting or mail it to:

Treasurer, MLMUG


P.O. Box 1374

Southeastern, PA 19399


Multimedia SIG Co-Chair 
Nicholas Iacona


nick@nickiacona.com

Newer Users SIG Co-Chair & 

Webmaster 
Bob Barton


barton@bee.net

OS/iOS SIG Chair 

Adam Rice

adam@adamrice.org

Picnic Coordinator 

Tony DiPiano

tony@dipiano.net


Raffle Chair 
Susan Czarnecki


sparsefur@yahoo.com 
Social Secretary 
Gail Montgomery


gailemontgomery@comcast.net


President, Program Director & 
Vendor Liaison 

Maria O. Arguello

mariarguello@mac.com


Vice President & Multimedia SIG 
Co-Chair 

Larry Campbell

lcampbell9@me.com


Treasurer, Membership & 
Facilities Coordinator 

Elliott Cobin

eicobin@gmail.com


Secretary & Newsletter Editor 
Mark Bazrod


msb@lpilease.com 
Educational Liaison 

Linda McNeil

mcneil.linda@gmail.com


Member-at-Large, Newsletter 
Copy Editor & Apple User Group 

Ambassador 
Deane Lappin


deanezl@verizon.net
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Typical Meeting Agenda


9:00 - 9:05: 	 Call to order in main meeting 
room.


9:05 - 10:15: Q&A Panel - 3 or 4 expert 
members will answer your questions 
about anything relating to your Mac, 
iPad, iPhone, iWatch, and any 
attached peripherals.


	 Questions can relate to the most basic 
items, equipment issues, Apple’s 
o p e r a t i n g s y s t e m s , a n d a l l 
applications, including applications for 
photo, video, audio, and print media.


	 Answers are amazingly helpful and 
often in depth, exploring the subject 
beyond the question.


10:15 - 10:30: Welcome and other business.


10:30 - 11:50: Main Presentation (by a 
member or guest)


11:50 - Noon: Raffles and silent auctions.


Come join some fellow MLMUG members 
for lunch after the meeting at a nearby 
restaurant. 

MLMUG Email list


The Main Line Macintosh Users 
Group has its own email list, 
hosted at Groups.io. Compose 
your letter and email it to 
MLMUG@groups.io  and your 
message will be sent to everyone 
on the mailing list. Contact Bob 
Barton (barton@bee.net) if you 
are a member and you are not on 
the list.

Please observe good email 
etiquette. If your message is 
humor or not Apple-related (off-
topic), please include "Humor" or 
"OT" in the subject line. The 
Groups.io Terms of Service are at 
groups.io/static/tos. Look for the 
section on "Conditions of Use"  

The MLMUG list may be used to 
post Apple-related items for sale, 
but any solicitation of members 
through the list is forbidden 
without the written consent of a 
MLMUG officer. Violation of the 
Groups.io terms of service or 
good email etiquette may result 
in removal from the list.

New Users SIG


You don’t have to wait a whole 
month to get answers to your basic 
Mac questions! Get together with 
other members on the fourth 
Saturday (i.e., two weeks after each 
regular meeting) for the Startup 
Folder Lite.


Many new users have said that they 
can learn much more from face-to-
face meetings than they do from 
manuals or other sources. That’s 
what this meeting is all about. Go 
to www.mlmug.org/nusfl.html for 
details.


http://groups.io
mailto:%20MLMUG@groups.io%20
mailto:barton@bee.net
http://groups.io/
https://groups.io/static/tos
http://groups.io/
http://groups.io
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https://groups.io/static/tos
http://groups.io/
http://www.mlmug.org/nusfl.html
http://www.mlmug.org/nusfl.html
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Bookmarks  
Stop Google From Tracking Your 
Data 
By Mark Bazrod 

Google gives you free mail, free YouTube, free maps, and other 
free services.You give Google your personal information and 
habits for free. Google gets and saves what you search for, how 
you search, your search patterns, the ads you’re interested in, 
the links you click, the images you view, which videos you watch, 
your location, what devices you use, and much more.

If you are concerned about privacy, what you can do to better 
protect and safeguard your Google searches.

CUT EVERYTHING OFF  
The simplest way to disallow Google from tracking your data is to 
simply not use any Google services. THAT’S EASIER SAID THAN 
DONE!

However, alternative search engines (I think DuckDuckGo is the 
best) are available that don't track your search history or collect 
any of your personal information. They use Google and Bing 
search engines, but Google doesn’t know the search is coming 
from you.

There are also many free email services you can use instead of 
Gmail, some which are even built around privacy.

YouTube (owned by Google) is another big part of the Google 
ecosystem, but it's not the only video sharing website out there. 
Look at best websites for free videos for some alternatives.

DON'T SIGN IN TO GOOGLE  
If you want to continue using Google without being tracked, you 
can definitely do so by simply not signing in to your Google 
account.


This option is somewhat of a double-edged sword, though, 
because while Google won't track your information, your search 
relevancy will decline because Google uses the information it 
collects about your movements and choices to refine and 
personalize search results. 

Using your browser's private mode is one easy way to use 
Google, YouTube, Google Maps, and other Google services 
without having to log in. You can run a search without it being 
logged by Google.

THE BEST TO AVOID GOOGLE GATHERING YOUR SEARCH 
INFO IS TO USE DUCKDUCKGO OR PRIVATE BROWSING.

CHECK YOUR GOOGLE MYACCOUNT SETTINGS  
You, as the user, have complete control over what data you 
choose to share or not share with Google. You can do this for 
each service you use with Google, from Gmail and YouTube to 
general search settings.

To control the information Google can gather about you, manage 
your personal info and privacy from your myaccount.google.com 
and access details from items in the left sidebar. It can take a lot 
of time.


5

https://bit.ly/3fSuRKJ
https://bit.ly/2OPtSz8
http://myaccount.google.com
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CONTROL THE ADS GOOGLE SHOWS YOU  

DO PERIODIC PRIVACY CHECKUPS  
Go to myaccount.google.com & click on Privacy Checkup.This 
tool helps you methodically check exactly what is being shared, 
& where. It’s a ton of work


CONCLUSIONS 
Stopping Google from using much of your information is time-
consuming.

Use DuckDuckGo and private browsing.

A good place to start is your myaccount.google.com. Access 
details from items in the left sidebar.

For more details about how to turn off Google tracking, take a 
look at cnet.co/3eRU1I2

You can’t prevent Google from getting some of your information, 
but you certainly can reduce the amount it gets.  

6

Many people don't know that you can review and control the 
kinds of ads that Google shows you and don’t take advantage 
of this amazing convenience, but it’s very easy to do from your 
Ad Settings page.  Go to myaccount.google.com, click on Data 
& Personalization, and go to Go to ad settings below Ad 
Personalization. Next go down to How your ads are 
personalized & select individual ad subjects. You can turn off 
individual categories. I’ve turned off more than 30.

http://myaccount.google.com
http://myaccount.google.com
https://cnet.co/3eRU1I2
http://myaccount.google.com
http://myaccount.google.com
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Jason Snell posted the following article to macworld.com on July 
22, 2020. bit.ly/30SIfIr. © Mac Publishing, LLC. Jason was lead 
editor at Macworld for more than a decade and now writes about 
Apple at Six Colors, podcasts at Relay FM and The 
Incomparable.and has been a technology writer for more than 20 
years. 

The Most Invisible And Influential Eras In 
Apple History 
Apple’s business approach and position in the market has varied 
over the years. 

By Jason Snell 

I wrote my first story about Apple in 1993, meaning I’ve been 
covering Apple for 60 percent of its existence. Lately, I’ve 
realized that beyond a few major milestones, most people don’t 
really remember Apple as anything but a technology titan. But 
the two very different Apples of the 1990s and early 2000s are 
worth remembering, rather than losing them in a hazy muddle 
that begins with Steve Jobs leaving Apple and ends with the 
arrival of the App Store.

I’ve tried to categorize the history of Apple into six distinct eras 
where the company’s approach and position were remarkably 

different, with special attention paid to the two most undersold 
eras in company history.


The Hobbyist Era (1976-1982) 
You know the story. Two guys named Steve built a company in a 
garage in the earliest days of the personal computing. There’s 
been plenty of myth-making about this era in Apple’s history, and 
for good reason. In 1982, high on Apple II sales, Apple hired John 
Sculley of Pepsi as its CEO, and this era came to an end.


The Corporate Era (1982-1992) 
This era encompasses the 
continued success of the 
Apple II, the release of the 
Macintosh, and the Mac’s 
growth under Sculley. It’s 
funny to think about how 
J o b s ’ s l e g e n d a r y 
shepherding of the original 
Mac project came as his 
power base in the company 
was crumbling, and a year 
after the Mac arrived, Jobs 
was gone.

What remained was a 
company that was ready to 
iterate on that original Mac 
and take it to some great 
places. The Mac became 
dominant in media circles 
thanks to the advent of 
desktop publishing. My first 
Mac was an SE, purchased 
in this period.

Apple grew a lot during this period, transforming from the 
legendary garage startup into a more traditional corporation. 

7

Macworld started out as a print 
magazine and the first issue was 
published during the Corporate 
Era.

https://bit.ly/30SIfIr
https://sixcolors.com/
http://www.relay.fm/
https://www.theincomparable.com/
https://www.theincomparable.com/
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Microsoft and IBM PCs loomed as threats, but the Mac was still 
clearly the best choice for the job—and the money flowed.


The Doom Era (1992-1998) 
I tell people that I started writing about Apple when it was 
doomed. And indeed, deciding to specialize in Apple computers 
in 1993 seemed about as smart as covering radio dramas during 
the roll-out of television. Microsoft was on the march, and the 
release of Windows 95 massively closed the gap between Macs 
and PCs, robbing Apple of one of its great advantages.

The PowerBook, released at the very start of this era, was a 
winning product that helped earn Apple a lot of goodwill. But that 
goodwill was rapidly squandered with the disastrous second-
generation PowerBook, the 500 series, and its even more 
disastrous successor, the PowerBook 5300.


PowerBook 5300cs, a symbol of the Doom Era. 
Apple CEO John Sculley was booted during this period, and his 
replacements got increasingly less inspiring. Apple had a whole 
lot of money during this period, and not a whole lot of sense, and 
it flailed around to find a solution that would allow it to become 
the legendary Apple of the previous era again. It also shot itself in 
the foot repeatedly, as it did when it licensed Mac OS to outside 
hardware makers to create Mac clones.


And just like that, the money ran out. Gil Amelio, the clueless 
executive left holding the bag, only had a few moves left. Even 
his single best decision as Apple CEO was a happy accident: 
Desperate to find a modern operating system because of Apple’s 
inability to build a new version of Mac OS, he ended up getting 
talked into buying NeXT.

Yes, NextStep became the foundation of all of Apple’s operating 
systems to this day. But even more important was that the 
founder of NeXT, Steve Jobs, came along with the purchase.


The Resurgent Era (1998-2008) 
The popular narrative of Steve Jobs’s return to Apple is simple: 
Jobs came back and saved everything. Which, yes, that did end 
up happening. But I think it gives short shrift to this very 
interesting period at Apple, where Jobs was back and putting his 
plans in motion—but Apple was also hungry to try anything and 
everything to get back in the game.

We remember the successes. The original iMac, introduced in 
1998, really marks the start of the turnaround. The iPod followed 
in 2001, and combined with the launch of Apple’s retail stores, 
Apple changed its brand, brought back the Mac, and primed the 
pump for the launch of the iPhone.


Apple's Steve Jobs (left) and Intel's Paul Otellini (right) talk about 
Apple's implementation of Intel processors in Macintosh 

computers. Apple WWDC 2005. 
8
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But there were failures and false starts, too. Apple’s partnership 
with IBM in 2003 led to Apple announcing the Power Mac G5 
and Jobs promising a 3GHz processor would be available within 
a year. IBM was never able to deliver, and Apple ended up having 
to jettison the entire PowerPC alliance and run into the arms of 
Intel, formerly Apple’s archenemy.

And in 2002, Jobs stood on stage, mocked Apple’s previous 
efforts to sell server hardware, and explained how Apple would 
remain committed with the new Xserve server, Xserve RAID 
storage array, and Mac OS X Server software. It was worth a 
shot, but it just didn’t work out—and both Xserve and Mac OS X 
Server slowly faded away as Apple found better areas in which to 
focus.

And then there were Apple’s bumbling attempts to add online 
services to its portfolio during this period, from .Mac to 
MobileMe. iCloud has evolved into a solid service, but only after 
more than a decade of belly flops.

Yes, there was magic in the early era of Jobs’s return. But it was 
hardly an effortless performance. In this era, Apple was sweating
—trying hard, and often, to find places where it could push itself 
forward. We remember the success, but maybe not the sweat.


The Era of Expansion (2008-2015) 
Beginning with the launch of the App Store in 2008, this is the 
era in which Apple went from being a big tech company to being 
one of the richest and most powerful companies in the world, 
largely on the growth of the iPhone.

In this era, Apple introduced the iPad, rapidly advanced iOS 
against competition from Android, honed its chipmaking skills, 
and made enormous amounts of cash.

By 2015, however, iPhone growth began to slow. You can mark 
the end of the era in 2015 or, if you prefer, 2018. But I’d argue 
that once iPhone growth slowed to a crawl, the era of Apple’s 
rapid expansion had come to an end.


The Tech Titan Era (2015-present) 
And then there’s the current era, in which Apple is finding growth 
in new areas beyond the iPhone—most notably wearables (Apple 
Watch, AirPods) and services. Apple’s a gigantic force in the 
world, the target of regulatory investigations and white papers 
from politicians who seek to limit its reach.


Apple has taken a commanding lead in the wearables market. 
Where does the company go from here? It seems like a return to 
Doom is unlikely, but there’s a real question about whether Apple 
is going to enter a period of senescence, where it makes loads of 
money but stops growing and changing, or if the corporate 
culture defined by Steve Jobs drives Apple’s current generation 
toward new products, new categories, and a constant 
reinvention of what Apple is.

If I’ve learned anything in the last 27 years, it’s that Apple rarely 
stands still for very long. Perhaps sometime this decade, Apple 
will exit its post-iPhone period and enter another exciting new 
period of growth and change. I sure wouldn’t bet against it.

 

9
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Yoel Minkoff posted the following article to seekingalpha.com on 
July 8, 2020. bit.ly/2ErGIS7. © Seeking Alpha. He is the face 
behind Wall Street Breakfast and news editor for the industrial 
goods sector. He joined Seeking Alpha in 2014. 

Apple Makes Up 43% Of Berkshire 
Hathaway's Portfolio 
By Yoel Minkoff 

• Berkshire Hathaway (BRK.A, BRK.B) held 245M shares of 
Apple (NASDAQ:AAPL) at the last count in May, making it 
Apple's second-largest shareholder with about 5.5% 
ownership of the company's public stock.


• Given the tech giant's stellar run over the past few months, 
the Buffett conglomerate now owns more than $91B worth 
of Apple, comprising 43% of its portfolio, writes The Motley 
Fool's Sean Williams.


• "Diversification is protection against ignorance," The Oracle 
once declared. "It makes little sense if you know what you 
are doing."


• "I don't think of Apple as a stock. I think of it as our third 
business," he added, referring to wholly owned subsidiaries 
Geico and BNSF. "It's probably the best business I know 
in the world.”[Editor Bolding]


• Apple is one of the megacap leaders that has strongly 
outperformed the broader market on its recovery from 
pandemic lows. Money has flown into the large tech and 
communication services stocks as a haven against the 
economic impacts on more cyclical names.


• Apple shares are up about 23% in the last 6 months, with 
the SPDR S&P down 3.4%.
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SOME SPEAKER ROSTER DETAILS 
January 11 - Bob Barton - Long time MLMUG member,  

presenter, Newer Users SIG Co-Chair, & Webmaster
February 8 - Mark Bazrod - Long time MLMUG member, 

presenter, and Newsletter Editor.
March 14 - Cancelled - Coronavirus
April 11- Fran Rabuck - Technology/Strategy Research 

Analyst, Visionary Communicator and Futurist
Todd Peters - IT Leader with vast experience
 integrating IT security and emerging technologies.

May 9 - Bob Barton - Long time MLMUG member, 
presenter, Newer Users SIG Co-Chair, & Webmaster

June 13 - Expert Panel - Zoom Meeting.
September 12 - .Mark Bazrod - Long time MLMUG 
  member, presenter, and Newsletter Editor. 

October 10 - Joe Myshko - Internet gateway designer and
 security expert
November 14 - Bob "Dr. Mac" LeVitus - a leading expert 
 on Apple products and software. Has written or co- 
 written more than 85 popular computer books. Known 
 for his trademark humorous style and unerring ability  
 to translate "techie" jargon into usable and fun advice 
 for regular folks. 

December 12 - Pot Luck Buffet, Member's Show and  
 Tell, and Election of Officers for 2021 - An   
 opportunity to enjoy friends, and good food, A "Show  
 and Tell” session will allow members 5, 10, or 15  
 minutes to present a topic. 

https://bit.ly/2ErGIS7
https://seekingalpha.com/symbol/BRK.A
https://seekingalpha.com/symbol/BRK.B
https://seekingalpha.com/symbol/AAPL
https://www.sec.gov/Archives/edgar/data/1067983/000095012320005345/xslForm13F_X01/form13fInfoTable.xml%0A
https://www.fool.com/investing/2020/07/06/this-stock-now-makes-up-43-of-buffetts-portfolio.aspx
https://www.fool.com/investing/2020/07/06/this-stock-now-makes-up-43-of-buffetts-portfolio.aspx
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Dan Moren posted the following article to macworld.com on July 
6, 2020. bit.ly/2P6jToU. © Mac Publishing.LLC. He is a 
Contributor at Macworld and has been writing about all things 
Apple since 2006. 

The Mac Never Left, But It’s About To 
Have A Comeback 
There’s never been a more exciting time to be a Mac user. 

By Dan Moren 

There’s never been a more exciting time to be a Mac user. 
And I say that as someone who’s been one for nearly 30 years 
now, ever since my dad brought home a Macintosh LC in 1991. I 
lived through the transition to PowerPC, the dark years of the 
nineties, and the move to both Mac OS X and Intel processors. 

Through all that time, the Mac has remained my workhorse. But 
in recent years, it often seemed as though the old stalwart had 
been overshadowed by the flashier iPhone and iPad lines, 
relegated to an afterthought in Apple’s mind. 

[ Further reading: Learn more about macOS Catalina ] 
After this year’s WWDC, however, the Mac is looking more like 
the Apple product that’s poised to have a huge impact. As we 
consider the calendar of the next couple years, there is a 
tremendous amount for Mac users to get excited about. 

Modeling good behavior 
Sometime later this year Apple will rolls out its first Mac models 
running on Apple silicon. That frisson of anticipation hanging in 
the air is because nobody has a really good idea what exactly 
those models might look like. And not just in an aesthetic sense, 
though that’s surely part of it. Will Apple opt for consistency, 
comforting Mac users by producing models that bridge the gap 
and change little, as the company did for the transition to Intel? 
Or is this a time to be bold, to push forward and demonstrate 
“This is what we can do when we’re in complete control of every 
piece of hardware and software”?  

I’m certainly hoping for the 
latter. Mac design in the last 
decade has, at times, felt 
staid and conservative. Sure, 
the latest MacBook Pro 
doesn’t look exactly  like its 
2006 predecessor, but neither 
i s i t a huge depar tu re . 
L i k e w i s e , t h e c u r r e n t 
generation iMac isn’t hard to 
trace back to the first aluminum iMac of 2007, but it’s honestly 
not even that distinct from the iMac G5 that preceded it.  

Could those really be the ultimate evolved forms of the Mac, the 
platonic ideals of notebook and desktop computing? The new 
Mac Pro certainly illustrates that the company can think outside 
of the box—or is that inside the box?—when it wants to. Plus, 
the engineering on the iPhone and iPad proves that when Apple 
does build its products from the ground up, it’s second to none.  
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Software everywhere 
Not only is Mac hardware about to get more capable than ever, 
but that hardware is about to be deluged with software. Not only 
will Macs be able to run the same apps they’ve been running for 
years, but now they’ll add hundreds of thousands of iPhone and 
iPad apps to the mix as well.


Your favorite iPhone apps could also end up on the Mac. 
It’s going to be a bit rough at first, to be sure. Not every iPhone 
or iPad app is going to be a great experience on the Mac. But the 
simple fact that users will be able to install a mobile app and run 
it seamlessly is a huge sea change. Plus, having those apps 
available on the Mac has the added benefit of possibly 
encouraging developers who ordinarily might not have 
considered the Mac as a platform to improve their apps to make 
them better Mac citizens. 

Throw in the huge collection of Unix-compatible software that it’s 
able to run, and the Mac is arguably the most versatile platform 
in existence, with everything from command-line software first 
deployed before the Mac even existed all the way up to an app 
designed for a smartphone in 2020. 

The Big Sur Prize 
On top of all that, Apple’s thrown in the most significant redesign 
of the Mac operating system since the debut of Mac OS X nearly 

two decades ago. Big Sur is sure to engender plenty of strong 
opinions amongst both admirers and detractors, but it’s difficult 
to argue that it’s not a bold move. 

That’s significant because, to my mind, you don’t make that kind 
of statement on a platform that you don’t care about. While some 
might see it as a sign of the Mac becoming more iPad-like, I’d 
argue that it’s about letting the Mac be the Mac, but borrowing 
from everything that Apple has learned in developing the iPad 
and the iPhone over the last decade-plus.  

The only constant is change, and if the Mac doesn’t adapt, it will 
die. Therefore, the fact that it’s changing to fit the times is a 
testament to its longevity. The Mac has been through far worse 
before, and it’s always survived; hard to say the same about any 
other technology product entering its fifth decade because, well, 
there just aren’t that many of them, are there?  

The Mac, as Phil Schiller once said, keeps going forever, so what 
we’re seeing now is just the start of the latest chapter in its long 
and storied history. And it looks like it’s going to be a good one.  
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Tim Brookes posted the following article to howtogeek.com on 
July 17, 2020. bit.ly/2X3WI3j. © MakeUseOf. He is Mac and iOS 
editor for MakeUseOf and lives in Melbourne, Australia.


7 macOS Tweaks To Boost Your 
Productivity 
By Tim Brookes  

Changing habits takes time and discipline, but changing a few 
macOS settings only takes a few seconds, and it can 
immediately boost your productivity. Here are some tips that will 
make your life easier on your Mac.


Increase the Cursor Size 
It might sound trivial, but size matters when it comes to your 
cursor. It’s easy to lose your pointer, especially when the OS 
auto-hides it while typing. But you can make things easier for 
yourself simply by increasing the size of the cursor under System 
Preferences > Accessibility > Display.

Use the “Cursor Size” slider to increase the size of the cursor 
until you’re happy with it. Even a small boost can make a big 
difference. You can also shake your cursor to locate it, but this 
takes a bit more time and effort than simply glancing at the 
screen.


This is especially useful if you’re using a “scaled” display mode 
under System Preferences > Display, in which the perceived 
resolution is increased to fit more onscreen.


Arrange the Dock Vertically, Not Horizontally 
By default, macOS puts the Dock at the bottom of the screen. 
While this looks fine, it can result in quite a bit of wasted space, 
as Macs now come with wide-screen displays. If the Dock isn’t 
full, you’ll have gaps on either side that windows never occupy. 
At the bottom of the screen, the Dock takes up more space than 
it would if you moved it to the left or right.

Placing the Dock vertically on either edge of the screen can 
recover a lot of wasted screen real estate. To fit your icons into 
the reduced vertical space, macOS compresses things 
somewhat. You can always  tweak the size of the dock further 
under System Preferences > Dock.
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Whether you choose the left or right edge largely depends on 
whether you’re right- or left-handed. If your right hand is 
dominant, you’ll have more room on the trackpad to move from 
left to right because your fingers will naturally rest on the right 
edge of the trackpad.

Moving the Dock to the left might feel more natural to those who 
use an alphabet that reads from left to right. The macOS Apple 
logo and Windows Start menu follow the same design principle.


Pin Useful Things to the Dock and Ditch 
Everything Else 
By default, macOS places some questionably “useful” apps in 
the Dock. If you decide you don’t need an icon in the dock 
anymore, click and drag it to the middle of the screen, and then 
release. You can also right-click an icon, and then uncheck 
Options > Keep in Dock.

Similarly, you can do the opposite and add any apps to the Dock 
so they’ll always be there. This is particularly useful for opening 
files in apps because you can just drag a file over an app icon to 
do so. Right-click an app and check Options > Keep in Dock to 
make it a permanent fixture.


Now, turn your attention to the right (or bottom, depending on 
your alignment) edge of the Dock. You can place folders here for 

quick access and open them as a list or grid. To do so, just drag 
a Finder window to the area beyond the Dock divider.

Right-click (or Control+Click) the folder to customize how folders 
are displayed. You can change the arrangement, choose the grid 
(expanded preview) or list view, and decide how items should be 
sorted. These folders can be destinations, as well—just drag and 
drop a file on the folder to which you want to move it.


Organize Windows by Keeping Apps on 
Specific Desktops 
If your desktop is a sea of ever-changing windows, you’ll never 
be able to find anything. If you’re not making use of the macOS 
“Spaces” feature that allows you to  place apps and windows 
across multiple desktops, you’re missing out!

You can see your available desktops via Mission Control. To 
launch it, press F3 or swipe upward with three fingers on the 
trackpad. At the top, you should see a numbered list of 
desktops. Click the plus sign (+) to add more or hover over a 
desktop, and then click the “X” to close it.




You can also use Mission Control to dump apps on specific 
desktops by dragging them into place. For example, you might 
want your primary browser to be on your first desktop, and apps 
like Slack or Evernote to be on your second or third.

To switch between desktops, either use a three-finger horizontal 
swipe or press Control+Right or Left Arrow.

To prevent an app from moving to another desktop and cluttering 
your workspace, right-click (or click and hold) its icon in the 
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dock, and then click Options > Assign to > This Desktop. Now, 
whenever you click that app’s icon in the dock, you’ll be taken 
straight to that desktop and app.

After a while, you’ll instinctively know where apps are based and 
on which desktop they’re located. You can skip to a specific 
desktop by holding Control and pressing its number. For 
example, to go to Desktop 3, you would just press Control+3. 
You can also use these keyboard shortcuts when dragging 
windows, tabs, or files.

The ultimate goal is to avoid juggling multiple windows on a 
single desktop. You can have up to 16 different desktops on your 
Mac, and they even work with multiple monitors, so use them!

RELATED: Mission Control 101: How to Use Multiple Desktops 
on a Mac


Group Windows as Tabs 
Many macOS apps now allow you to group separate windows as 
tabs, so you can keep everything within the same interface. To 
see if an app supports this feature, click View > Show Tab Bar. A 
plus sign (+) will appear if this feature is available; click it to open 
a new tab of the app. You can also use the traditional 
Command+T shortcut to do this.

If you already have a bunch of windows open on your desktop, 
you can merge them into a single tabbed interface by clicking 
Window > Merge All Windows. If you want to turn a tab into a 
window again, simply click and drag the tab bar outside the 
window.

This works well in Safari and other browsers, but it also applies 
to Apple’s iWork suite (Pages, Numbers, Keynote), Apple Maps, 
TextEdit, and Mail. You can also change the default behavior so 
apps like this open new windows as tabs every time. To do this, 
head to System Preferences > Dock, and select “Always” instead 
of “Prefer Tabs When Opening Documents.”


Authorize Your Mac with Your Apple Watch 
If you have an Apple Watch, you can use it to unlock your Mac 
automatically. You’ll need an Apple Watch running watchOS 3 
and a compatible Mac  for this to work (most models produced 
after 2013 should be fine).

To set it up, head to System Preferences > Security and Privacy 
and enable the “Use Your Apple Watch to Unlock Apps and Your 
Mac” option.

Now, whenever your Mac senses that you’re nearby, it will unlock 
automatically without you having to type your password. You can 
also use your Apple Watch to approve Admin-level requests on 
your Mac, like editing locked preferences or executing sudo 
commands in Terminal.


Force Safari Reader View on Specific 
Websites 
The web is distracting. You might go looking for instructions on 
how to make a tally graph in Microsoft Excel, but end up reading 
a super-interesting article about hosting your own VPN  instead. 
Some websites are just packed with great content, you know?
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Safari’s Reader View can help you focus solely on the content 
you went looking for by eliminating distractions. You can force 
Safari to enter Reader View on specific websites. When you do 
so, only the articles are affected—you can still browse the main 
site normally.

To do this, head to a website you read frequently read, click an 
article, and then look for the Reader icon in the address bar. Click 
it to see a preview of Reader mode. If you click and hold it, you’ll 
see an option to “Use Reader Automatically” whenever you visit 
the website you’re currently viewing.


With this enabled, every time you read an article on that domain
—whether you get there via the main index or through a web 
search—it will default to Reader view. You can also click “Safari” 
in the menu bar and go to Preferences > Websites > Reader to 
set the Reader mode preferences.


Work Smarter, Wherever You Are 
Taking a moment to tweak your workflow can make a huge 
difference in your productivity.


However, these tips merely scratch the surface—there’s a lot 
more you can do to make working from home on your Mac an 
easier, more pleasant experience.

RELATED: 12 Tips for Video Conferencing While You Work From 
Home
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Bob LeVitus posted the following article to macobserver.com on 
July 9. 2020. bit.ly/30bzxWN. © The Mac Observer. Bob is the 
author of more than 80 books, a computer columnist, and Mac 
expert. He writes a weekly column for The Mac Observer and is 
one of my favorite authors and speakers. 

The Magic of Mac’s Option Key 
By Bob LeVitus 
I was listening to my favorite podcast (Mac Geek Gab) and heard 
a tip that involved pressing the Option key while selecting a 
menu item or adding the Option key to a keyboard shortcut. 
Either way, you get a different result than if you did not press 
Option.


Moving vs. Copying Files or Folders 
For example, the tip on Mac Geek Gab explained how to move a 
file or folder using the Copy and Paste commands. Without the 
option key, you can use the Copy command to copy most files or 
folders from one location to another. But, that leaves you with 
two copies of the same file or folder in two different places on 
your disk. It would be nice if you could use the Cut command to 
move the file instead of duplicating it, but the Cut command isn’t 
available when you select a file or folder…

The solution is to hold down the Option key before you paste the 
file or folder. When you do, the Paste command in the Edit menu 
changes from “Paste” to “Move Item Here.” Or, add the Option 
key to the Paste keyboard shortcut (press Command + Option + 
V) to move the item instead of copying it.


Close All Windows at Once 
Another Option key shortcut works with the Close Window 
command. If you press Option before choosing File�Close 
Window, the command transforms into Close All and closes all 
open windows instead of closing only the active window. I like 
this one so much I memorized its keyboard shortcut—Command 
+ Option + W—and use it regularly.

To discover even more Option key magic, click to open a menu 
and then press the Option key and look for commands that have 
changed. For example, if you click the Finder’s File menu and 
then press Option, these commands change:


• Open becomes Open and Close Window, which is handy 
when you don’t want a disk or folder icon to open in a 
separate window or tab.


• Get Info becomes Show Inspector. The Inspector is a 
context-sensitive rendition of the Get Info window that 
updates in real-time to reflect the currently selected item 
(or items) in the Finder. In other words, rather than 
selecting an item and choosing Get Info, with the 
Inspector, you can just click any icon (or icons) and the 
Inspector updates to display the info for whatever is 
currently selected.


• Open With becomes Always Open With.


• Add to Dock becomes Add to Sidebar.


• Move to Trash becomes Delete Immediately.
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The File menu with (left) and without (right) the Option key. 

By the way, this Option key magic isn’t limited to the Finder—the 
Option key also changes some commands in many Apple apps. 
To find these hidden shortcuts, open a bundled app, open a 
menu, and then press the Option key and observe which 
commands change. (Hint: You’ll find most of them in the File or 
Window menu).


Michael Simon posted the following article to macworld.com on 
July 7, 2020. bit.ly/2X213Uk.. © Mac Publishing, LLC. He has 
been a Contributing Writer at Macworld since March 2014. 

After The Mac's Processors, Apple's 
Next Transition Is Apps 
Less launching, more convenience. 

By Michael Simon  

Over the next two years, we're going to hear a lot about Apple’s 
next transition. The move from Intel to Apple’s homegrown silicon 
is one of the biggest moves the company has ever made, one 
that’s sure to impact the rest of the industry as much as the Mac 
itself.  
But that’s not the only transition that Apple is embarking on. It 
might not have gotten its own segment during the WWDC 
keynote, but Apple laid down the tracks for a major shift away 
from traditional apps over the next several years. It won’t be as 
sudden or even as quick as the move to Apple’s silicon, but 
before long apps aren’t going to be something we need to 
download before we can use them. Rather they’re going to be 
ever-present, glanceable, dynamic, and agnostic extensions that 
adapt to both our location and the device we’re using without 
needing to visit a store.  

Widgets widgets everywhere 
The iPhone may have kicked off the “there’s an app for that” 
mentality, but you need to look no further than the iOS 14 home 
screen to see how Apple’s ubiquitous handset is moving beyond 
a home screen littered with icons of every task. It’s not just the 
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App Library, which literally removes icons from our view, but also 
the elevation of widgets. 
[ Further reading: Everything you need to know about iOS 13 ]

Widgets will take away the need to habitually launch apps 
whenever we need to know something.

In iOS 13, widgets are deliberate. They’re hidden behind a swipe, 
stacked in an infinite scroll, and not all that easier to use than an 
actual app, but in iOS 14 they’ve been elevated to front-and-
center glanceable objects that will actually cut down on the 
number of times we need to open our favorite apps. From 
weather forecasts to sports scores and news, widgets give you a 
reason to stay out of your apps by putting relevant information 
within constant eyesight. Apple will even be spotlighting popular 
ones in the gallery so you can download an app strictly to use 
the widget. 
And that means we’re going to be using the accompanying app 
less. The iPhone’s home screen has always been little more than 
a shortcut to your apps, but in iOS 14, it’s going to be a 
destination. You’ll be able to unlock your phone, glance at a 
widget or swipe through a stack, and put it back in your pocket 
all without never opening an app. 

Piece by piece 
Somewhat ironically, App Clips will reduce our dependency on 
apps as well. Designed to deliver small pieces of apps when and 

where we need them, App Clips are by nature ephemeral, serving 
a specific purpose and then disappearing.

App clips are like downloading apps except quicker, smarter, and 
more convenient.

They may function like the apps, but App Clips are a very 
different animal. You don’t use the App Store to find them, you 
don’t explore menus or save files, you don’t even keep them 
around after you’re done using them. They serve a specific 
purpose and poof, they’re gone. They’re apps in name only, and 
if developers adopt them as quickly as they should, App Clips 
will usher in a whole new way of installing apps. 
Apple didn’t announce App Clips for Apple Watch, but they make 
even more sense there. Even with an on-watch store and a list 
view for the honeycomb home screen, finding apps to buy and 
use isn’t all that pleasant on the Apple Watch. But App Clips 
could be a game-changer, turning app discovery into a smart, 
effortless extension of the watch face with tools that arrive when 
we need them and disappear when we don’t. We wouldn’t need 
to load up out watch with apps we rarely, and most importantly, 
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App Clips would take the focus off apps on put it where it 
belongs: the watch face and complications. 

The future of apps 
Of course, apps aren’t going anywhere for a while. In fact, Apple 
is launching a brand new one in iOS 14 called Translate that does 
what you’d expect: help you learn and communicate in foreign 
languages. As it stands you’ll need to open it and interact with it 
like any other app, but it’s easy to see a future where it just works 
without needing the app.


Translate is an app now, but it won't be forever. 
While the Translate app is for the iPhone now, it’s much more 
suited for Apple’s always-on and always-connected wearables. 
Translate could be built into future AirPods as a sort of Babel 
Fish that automatically translates into your native tongue when it 
detects another language. Or your Apple Watch could use Siri to 
translate on demand. And a future pair of Apple glasses could 
translate signs and images just by looking at them. 
Translate is a perfect example of how apps could evolve beyond, 
well, apps. Just like App Clips, future apps could be integrated 
into the system like (or with) Siri and just work without needing to 

launch an app. Maps could be ready when we get in our car. 
Apple Music or Spotify when you start a run or pop in your 
AirPods. Or Target when you walk into the namesake store. And 
with Apple silicon soon powering every device, switching 
between them will be seamless and dynamic. 
Of course, Apple has to get through the Mac's transition, but 
once that's dons, apps are next. It’s not that they're going away. 
We're always going to need a place to play music, browse stores, 
and get directions. But the way we access those tools could be 
very different in a few short years. 
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Sam Costello posted the following article to lifewire.com on 
January 24, 2020. bit.ly/39ywvig. © About.com. He is a 
consultant and writer since the Mac Plus. He has written 
hundreds of articles, tutorials, and product reviews. 

The Full Rundown of Apple's Handoff  
By Sam Costello  
Ever started doing something on your Mac, had to run out of the 
house, and then wish you finished it? We've all been there, and 
with Handoff, a feature built into the iOS and macOS, you can 
complete tasks on the go with ease.


An Introduction to Handoff on Mac and iOS  
Handoff, which is part of Apple's suite of continuity features that 
help Macs and iOS devices work together better, lets you move 
tasks and data seamlessly from one device to another. Other 
parts of Continuity include the ability for phone calls coming to 
your iPhone to ring and be answered on your Mac.

Handoff lets you start writing an email on your iPhone and pass it 
to your Mac for completion and sending. Or, to map directions to 
a location on your Mac and then pass to your iPhone for use 
while you're driving. 


Handoff Requirements  
To use Handoff, you need the following things:


• A Mac running OS X Yosemite (version 10.10) or higher.

• An iPhone, iPod touch, or iPad running iOS 8 or higher.

• An Apple Watch (optional, but it works with Handoff, too).

• Bluetooth enabled on both devices.

• Both devices signed into the same iCloud account using 

the same Apple ID.


Handoff-Compatible Apps  
Certain pre-installed apps that come with Macs and iOS devices 
are Handoff-compatible, including Calendar, Contacts, Mail, 
Maps, Messages, Notes, Phone, Reminders, and Safari.  The 
iWork productivity suite also works: on a Mac, Keynote v6.5 and 
up, Numbers v3.5 and up, and Pages v5.5 and up; on an iOS 
device, Keynote, Numbers, and Pages v2.5 and up.

Some third-party apps are also compatible, including Airbnb, iA 
Writer, The New York Times, PC Calc, Pocket, Things, and more.


How to Enable Handoff  
1. On both the Mac and iOS devices, make sure you're 

signed into iCloud using the same Apple ID.

2. On both devices, enable Bluetooth.

3. On the Mac, make sure Handoff is turned on by clicking 

on the Apple menu > System Preferences  > General, 
then check the box next to Allow Handoff between this 
Mac and your iCloud devices.


4. On the iOS device, tap Settings > General > Handoff (on 
older versions of the iOS, this is called Handoff & 
Suggested Apps), then  ensure the Handoff slider is 
moved to on/green.


How to Use Handoff From iOS to Mac  
Now that you've got Handoff enabled on all your devices you can 
use it to make your life easier. In this example, we'll go over how 
to start writing an email on your iPhone and then move it to your 
Mac using Handoff. Remember: this is just one way to use 
Handoff. You can follow this same technique with any Handoff-
compatible app.


1. Begin by launching the Mail app on your iPhone

2. Tap the new mail icon in the bottom right corner.
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3. Start writing the email. Fill out as much of the email as you 
want: To, Subject, Body, etc.


4. When you're ready to hand the email off to your Mac, go 
to your Mac and look at the Dock.


5. At the far left end of the Dock, you'll see the Mail app icon 
with an iPhone icon on it. If you hover over it, it reads 
"Mail From iPhone."


6. Click the Mail from iPhone icon.

7. Your Mac's Mail app launches and the email you were 

writing on your iPhone will load there, ready to be 
completed and sent. 


How to Use Handoff From Mac to iOS  
To go the other direction — moving 
content from a Mac to an iOS device 
— follow the steps appropriate for the 
version of the operating system you 
have. We'll use getting directions via 
the Maps app as the example, but like 
with the previous section, any Handoff-
compatible app will work in basically 
the same way.


If You're Running iOS 9 and 
Up  

1. Launch the Maps app on your 
Mac and get directions to an 
address.


2. Open the multitasking view by 
double-cl icking the Home 
button or swiping up from the 
bot tom of the screen on 
iPhones that don't have a Home 
button.


3. At the bottom of the screen, look for the name of the app 
and computer you're handing off from.


4. Tap that and the app will open and load the content from 
your Mac.


If You're Running iOS 8

1. Launch the Maps app on your Mac and get directions to 

an address.

2. Open the multitasking view (on recent versions of the iOS; 

if you have an older version, press the Home or on/off 
buttons on your iPhone to light up the screen, but don't 
unlock it).


3. In the bottom left-hand corner, you'll see the Maps app 
icon


4. Swipe up from that app (you may need to enter your 
passcode (if you use one)


5. When your phone unlocks, you'll jump to the iOS Maps 
app, with the directions from your Mac pre-loaded and 
ready for use.


Handoff also appears in the Dock on iPads running iOS 11 and 
up. To learn all about the iPad Dock, check out How to Use The 
Dock In iOS 11 and iOS 12.
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Heinz Tschabitscher updated the following article at about.com 
on February 26, 2020. bit.ly/3hIHIzA. © about.com. Since 
1997,he has been covering all aspects of email and other forms 
of online communication for about.com. 

How to Stop Apple Mail From Spam 
Filtering Known Senders  
Make sure important emails don't end up in the junk folder 

By Heinz Tschabitscher  
Apple Mail has been the standard for Mac email since the early 
days of OS X. Apple Mail's built-in junk mail filter is powerful, 
precise, and very helpful for weeding out spam. It is not, 
however, immune from misjudgment.


If you find that important, valid emails from known senders are 
being assigned to your junk mail folder, it's easy to stop Apple 
Mail from identifying messages from certain senders as spam. 
This process is called whitelisting, and it ensures that good 
messages head straight to your Inbox.

Note: These instructions should apply to all versions of Apple 
Mail.


Stop Email From Being Incorrectly Marked as 
Spam  
To prevent Apple Mail from incorrectly marking legitimate 
messages as junk:


1. Select Mail > Preferences from the menu in Apple Mail.

2. Select the Junk Mail tab.

3. Make sure Enable Junk Mail Filtering is checked.

4. In the section labeled The following types of messages are 

exempt from junk mail filtering, place a check mark in the 
box in front of Sender of message is in my Contacts.


5. Optionally, check Sender of message is in my Previous 
Recipients, as well.


6. Optionally, check Message is addressed using my full 
name.


7. Close the Preferences window.
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8. Now, Apple Mail won't mark messages as junk if they 
come from anyone in your Contacts list or anyone with 
whom you've corresponded previously, or if the message 
is addressed using your full name, depending on which 
options you chose.


Tip: Alternatively, select the Not Junk button in the banner of the 
message, or select the message, then select the Not Junk 
button in the Mail toolbar.


How to Add a Sender to Your Contacts  
It's easy to add senders to your Contacts so their messages 
won't be marked as junk mail.


1. Open Apple Mail and then open an email from the sender.

2. Highlight the sender's name or email address at the top 

of the email by moving your cursor over it.

3. Select the arrow that appears at the end of the 

highlighted name or email address.

4. Select Add to Contacts from the drop-down menu to 

open the information in the Contacts application.

5. Enter any additional information for the contact and select 

Done.

6. The sender is now in your Contacts list.


Tip: This method of whitelisting protects individual email 
addresses, but it doesn't apply to entire domains. It's possible, 
however, to whitelist domains by creating a Rule in Apple Mail's 
Preferences.


The following article was posted to the Kibbles & Bytes Email 
Newsletter #1105 on June 15, 2020. bit.ly/30VioQ5. 

Troubleshooting eMail Problems 
One of the most common questions we are asked is "Help, my 
eMail is not working..." or  "Help, I cannot send eMail" or "Help, 
my eMail disappeared.." . Troubleshooting these eMail issues is 
complicated by the myriad of eMail clients, servers and accounts 
as well as issues of connectivity unrelated to eMail. 
When a friend calls with eMail issues, my first question is always 
- "do you have internet?" and I ask them to go to Safari and try 
to surf to a website that they do not normally visit (to avoid any 
caching issues).   If connectivity is the issue, we go through the 
steps of restarting the radios on the Mac, iPad or iPhone by 
putting them in Airplane mode and taking them off.   If that 
doesn't work, we may try restarting the device, investigating 
whether the internet service provider is having a downtime, or 
restart the modem or router. 

But if they successfully surf to the random website that I give 
them, perhaps my favorite restaurant or lefty political news site, 
we have to look at other issues to address mail.  Mail servers go 
down and it is pretty simple to determine if your server is down. 
Unfortunately, that is usually not the problem. 
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If you are not receiving eMail here are some suggestions of steps 
to try: 

• Check whether Mail is retrieving a large message or a 
message with large attachments. You can choose the 
"Activity" menu item to see if it is hung up on that 500MB 
download. 

• Check if you’re using filters in the message list that are 
preventing expected messages from being shown. 

• Try sorting messages in the message list by Date or 
another attribute, or searching for messages, to verify if 
you received them. 

• Check whether your account is offline or disabled 
(inactive). 

• If you’re missing emails from a specific person or group, 
check whether you blocked messages from them. 

• Try quitting Mail, then opening it again. 
• Choose Window  > Connection Doctor, then follow any 

instructions in the Details column. Check for problems 
logging in to email accounts or with the incoming mail 
server, or with firewall software blocking network traffic. 

• Check whether you’re affected by another firewall, such as 
software installed separately from macOS or built into an 
internet sharing router, or administered by your email 
account provider. 

• If you’re still having problems, contact your email account 
provider to verify your user name, password, incoming 
mail server, and other required information. Then verify that 
  the information is entered correctly in Mail account 
preferences. 

• Many email providers offer webmail, which is a way to use 
email with a web browser such as Safari, instead of with an 
email app such as Mail. For example, if you're using an 
iCloud Mail account, you can use iCloud.com to send and 
receive email, if you use Gmail you can use gmail.com or if 
you are wicked old and still have an AOL account - get a 
new account! 

Webmail is a good way to verify that your account is valid and 
you can sign in to it from the web, but it doesn't mean that your 
account is set up correctly in Mail. If a mail server doesn’t accept 
your user name and password, try these  suggestions. 
Not receiving? 
You might see a status icon such as a  lightning bolt or warning 
symbol next to your account's inbox in the Mail sidebar, or in the 
upper-right corner of the Mail window. Click it to learn more.

• If the status is Network Offline, make sure that your Mac is 

connected to the Internet, then try again. 
• If the status is Login Failed, check with your email provider 

to be sure that your account is set up correctly on your 
Mac. 

• If Mail asks for your password, but entering the password 
doesn't help, find out why your email provider is rejecting 
your password. 
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• If your email service is temporarily unavailable, your email 
provider might have a status message on their website. 
For example, Apple's system status page shows the status 
of iCloud Mail. Status pages are also available for other 
email services, such as Gmail and Outlook.  Some brief 
service outages might not appear on a system status 
page, so you might want to wait a few hours and try again. 


In the Mail app on your Mac or your eMail client, do the 
following:  
• Make sure you enter the password for your email account, 

not the login password for your Mac or the password for 
another account. 

• Make sure you enter uppercase and lowercase characters 
where needed. 

• Verify your login information. Choose Mail > Preferences, 
then click Accounts. 

If people tell you that they are not receiving your emails you can 
try these steps: 
• Make sure the person’s email address is correct. Ask the 

person to send you a message, then reply to it. Now the 
email address is in the Previous Recipients list in Mail and 
should be correct. 

• Some mail servers reject messages that exceed a certain 
size. If your message includes attachments, use Mail Drop 
or try resizing image attachments. 

• Send yourself a test message. If you receive it, ask people 
to send themselves a test message to see if the mail 
server for their email accounts has a problem. 

• Use Connection Doctor to check your network connection. 
• Ask your email account provider whether it limits the 

number of people you can send a message to at one time, 
as a way to prevent junk mail. 

• Some mail servers won’t deliver a message to any of the 
recipients if even one address is invalid. When this 
happens, Mail alerts you that the message wasn’t sent. 
Open the message (it’s in your Outbox) and remove or 
correct invalid addresses, then send the message again. 

If you have just gotten a new Mac or iPhone and are setting up 
eMail for the first time, realize that it does take some time for the 
device to download your messages from the server, especially if 
they contain large attachments such as pictures or videos. 
As I think about the hundreds of calls about "no eMail!" I believe 
the top causes are: 

1. No internet connection 

2. Mail is hung up on a gigantic download 

3. eMail provider has a temporary outage 

4. eMail client settings are wrong 
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Adam C. Engst posted the following article to tidbits.com on 
June 11, 2020. bit.ly/39BB3UT. © TidBITS Publishing Inc. He is 
the publisher of TidBITS. He has written numerous books and 
many magazine articles. 

Beware! iCloud Backups Deleted after 
180 Days 
By Adam Engst 
TidBITS reader Walter Ian Kaye had a simple question: “Did you 
know Apple deletes iCloud backups over 180 days old? I didn’t.

I’m always bemused when I discover myself adopting one of my 
son’s expressions, and my immediate reaction was a teen-speak 
refrain from his high school years: “Wait, what?”

I had no idea that Apple deleted iCloud backups after 180 days, 
and a quick poll in the TidBITS Slack channel showed that it 
wasn’t common knowledge among other TidBITS staffers and 
contributing editors.

But a quick Google search revealed that the policy is far from 
new—I see perturbed iCloud users complaining as far back as 
2014, and Take Control author Kirk McElhearn mentioned the 
fact in a 2013 Macworld article.

Apple does document this fact in various places, including in the 
iCloud User Guide, the Manage Your iCloud Storage support 

document, and the iCloud Terms and Conditions. But if you were 
expecting that you might be warned about such a limitation in 
the iOS interface, such as on the screen where you enable iCloud 
Backup or learn more about what’s backed up, you’d be 
disappointed.


Apple’s acknowledgment of the deletion policy is not quite as 
hidden as the plans for demolishing Arthur Dent’s house in The 
Hitchhiker’s Guide to the Galaxy. But the effect is roughly the 
same if you were planning on restoring from your iCloud backup, 
only to discover that Apple had deleted it, with the only warning 
being in support documents you’ve never read.

On the one hand, it makes some sense that Apple would want to 
delete device backups—which can be quite large—that no one is 
ever going to want to use again. With hundreds of millions of 
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devices backing up to iCloud, the storage requirements boggle 
the mind.


But on the other, what was Apple thinking?!? Deleting a user’s 
one and only backup, particularly without clear documentation in 
the user interface and express warning of the pending deletion, is 
simply unacceptable.


Of course, most people will never run into this problem. It’s 
unusual that someone would make a backup and then let it sit for 
over 6 months before wanting to restore. Unusual, but far from 
impossible. Walter had backed up a dying iPad and was saving 
the money to replace it, assuming that he’d be able to restore 
because he was paying Apple every month for 200 GB of iCloud 
storage space.


Apple clearly already has a scheduled process that checks 
backup age and deletes backups over 180 days old. It can’t be 
that difficult for Apple’s engineers to adjust that process to send 
out an email message to the user saying:


Your iCloud backup for “Adam’s iPad 2” made on January 1st, 
2020, expires on June 30th, 2020. It will be deleted after that 
unless you make another backup using that device before then.

Even better would be to include in that email message a link the 
user could click to reset the 180-day counter. That would let 
people like Walter prevent the backup from expiring until they 
could restore it.

In the meantime, if you want to ensure that an iOS device backup 
sticks around indefinitely, you’ll need to back it up to your Mac, 
using either the Finder in macOS 10.15 Catalina or iTunes in 
previous versions of macOS (there are other differences between 
the backup types as well, though the 180-day limit isn’t 
mentioned). Unfortunately, local backups can consume 
significant space (my iPhone 11 Pro’s backup is over 67 GB). 
Plus, they must be stored in ~/Library/Application Support/
MobileSync/Backup/, which is problematic for those with small 

boot drives—that was why Walter was using iCloud Backup in 
the first place.
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Tim Brookes posted the following article to howtogeek.com on 
June 19, 2020. bit.ly/2X1WpWw. © MakeUseOf. He is Mac and 
iOS editor for MakeUseOf and lives in Melbourne, Australia. 

8 Tips for Saving Battery Life on Your 
iPhone 
By Tim Brookes  

Everyone wishes their iPhone battery would last longer. While we 
all patiently wait for a breakthrough in battery technology, there 
are a few things you can do to save power and maximize your 
iPhone’s battery life. 

Make Sure “Optimized Battery Charging” Is 
Enabled 
Apple’s iOS 13 update introduced a new feature designed to 
protect your battery by limiting its total charge until you need it. 
The feature is called Optimized Battery Charging. This should be 
enabled by default, but you can double-check under Settings > 
Battery > Battery Health. 


Lithium-ion cells, like those used in your iPhone, degrade when 
they’re charged to capacity. iOS 13 examines your habits and 
limits your charge to around 80 percent until the time you usually 
pick up your phone. At that point, it charges to maximum 
capacity. 
Limiting how long the battery spends at greater than 80 percent 
capacity should help extend its life. It’s normal for a battery to 
degrade as more charge and discharge cycles are completed, 
which is why batteries eventually have to be replaced. 
Hopefully, this feature will help you get a longer life out of your 
iPhone’s battery. 

Identify and Eliminate Battery Hogs 
If you’re curious where all your battery’s power is going, head to 
Settings > Battery and wait for the list at the bottom of the 
screen to calculate. Here, you can see the battery usage by each 
app for the last 24 hours or 10 days. 

Use this list to improve your habits by identifying which apps are 
using more than their fair share of power. If there’s a particular 
app or game that’s a serious drain, you could try limiting your 
usage, only using it when connected to a charger, or even 
deleting it and seeking an alternative. 
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Facebook is a notorious battery drainer. Deleting it might provide 
the biggest boost to your iPhone’s battery life. However, you’ll 
also likely find something better to do than mindlessly scrolling 
your feed. An alternative that won’t drain your battery quite as 
much is using Facebook’s mobile website instead. 

Limit Incoming Notifications 
The more your phone interacts with the internet, particularly over 
a cellular network, the more battery life is drained. Every time you 
receive a push request the phone has to access the internet, 
download it, wake up the screen, vibrate your iPhone, and 
maybe even make a sound. 
Head to Settings > Notifications and turn off anything you don’t 
need. If you’re checking Facebook or Twitter 15 times a day, you 
probably don’t need the full gamut of notifications. Most social 
media apps allow you to tweak your notification preferences in-
app and reduce their frequency. 

You can even do this gradually. Tap and hold any notification you 
receive until you see an ellipsis (. . .) in the top-right corner of the 
notification box. Tap this and you can quickly change the 
notification settings for that app. It’s easy to get used to 
notifications you don’t need, but now, it’s just as easy to get rid 
of them, too. 

In cases like Facebook, which might be using a significant 
portion of your iPhone’s energy, you can try disabling 
notifications altogether. Another option, again, is to delete the 
Facebook app and use the web version instead, via Safari or 
another browser. 

Got an OLED iPhone? Use Dark Mode 
OLED displays create their own light rather than relying on a 
backlight. This means their power consumption varies based on 
what they’re displaying onscreen. By opting for darker colors, 
you can reduce the amount of power your device uses quite 
dramatically.

This only works with certain iPhone models that have a “Super 
Retina” display, including the following: 

• iPhone X 
• iPhone XS and XS Max 
• iPhone 11 Pro and Pro Max 

If you turn on Dark mode under Settings > Display, you could 
save around 30 percent of the battery charge according to one 
test. Pick a black background for best results, since OLED 
models replicate black by completely turning off sections of the 
display.  
You can use Dark mode on other iPhone models, you just won’t 
see any improvement in battery life.  

Use Low Power Mode to Extend a Remaining 
Charge 
“Low Power Mode” can be accessed under Settings > Battery, or 
you can add a dedicated shortcut to it in “Control Center.” When 
you enable this feature, your device will go into power-
preservation mode.  
It does all of the following: 

• Limits screen brightness and reduces the delay before the 
screen turns off 
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• Disables automatic fetching of new mail 
• Disables motion effects (including those in apps)  and 

moving wallpapers 

• Reduces background activities, like uploading new images 
to iCloud 

• Clocks down the main CPU and GPU so the iPhone runs 
slower 

You can use this feature to your advantage if you want to stretch 
the battery’s charge over a longer period. It’s perfect for those 
times when you’re not using your device, but want to remain 
connected and available for calls or texts.

Ideally, you shouldn’t rely on Low Power Mode all the time. The 
fact that it reduces the clock speed of your CPU and GPU will 
result in a noticeable decrease in performance. Demanding 
games or music-making apps might not function as they should.  
RELATED: How to Use Low Power Mode on an iPhone (and 
What Exactly It Does)  

Cut Down on Features You Don’t Need 
Disabling thirsty features is a great way to improve overall battery 
life. While some of these are genuinely useful, we don’t all use 
our iPhones in the same way. 
One feature that even Apple suggests you disable if battery life is 
an issue is “Background App Refresh,” under Settings > General. 
This feature allows apps to periodically become active in the 
background to download data (like email or news stories), and 
push other data (like photos and media) to the cloud.

If you manually check your email throughout the day, you can 
probably get rid of new mail queries altogether. Head to Settings 
> Passwords and Accounts and change “Fetch New Data” to 
“Manually” to disable the setting altogether. Even reducing the 
frequency to hourly should help. 

Head to Settings > Bluetooth and disable it if you’re not using it. 
You can also turn off “Location Services” under Settings > 
Privacy, but we recommend leaving this on, as so many apps 
and services rely on it. While GPS used to be a serious battery 
drain, developments, like Apple’s motion co-processor, have 
helped to significantly reduce its impact. 
You might also want to disable “Hey Siri” under Settings > Siri so 
your iPhone isn’t constantly listening for your voice. AirDrop is 
another service used to transfer files wirelessly that you can 
disable via Control Center, and then re-enable  whenever you 
need it.  
Your iPhone also has widgets you probably occasionally activate 
on the “Today” screen; swipe right on the Home screen to 
activate it. Every time you do this, any active widgets query the 
internet for new data or use your location to provide relevant 
information, like weather conditions. Scroll to the bottom of the 
list, and then tap “Edit” to remove any (or all) of them. 
Limiting screen brightness can help preserve battery life, too. 
Toggle-On the “Auto-Brightness” option under Settings > 
Accessibility > Display and Text Size to automatically reduce 
brightness in dark conditions. You can also turn down the 
brightness periodically in “Control Center.”


Favor Wi-Fi Over Cellular Connection 
Wi-Fi is the most efficient way your iPhone can connect to the 
internet, so you should always favor it over a cellular network. 
The 3G and 4G networks (and eventually, 5G) require more power 
than plain old Wi-Fi, and will drain your battery significantly 
faster. 
This might prompt you to disable cellular data access for certain 
apps and processes. You can do so under Settings > Cellular (or 
Settings > Mobile in some regions). Scroll to the bottom of the 
screen to see a list of apps that have access to cellular data. 
You’ll also see how much data they’ve used during the “Current 
Period.” 
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The apps you might want to disable include the following: 
• Music streaming services: Like Apple Music or Spotify.  
• Video streaming services: Like YouTube or Netflix.  
• The Apple Photos app. 
• Games that don’t require an online connection. 

You can also explore individual apps and reduce their reliance on 
cellular data without completely disabling this option. 
If you’re ever away from your Wi-Fi connection and have an issue 
accessing a particular app or service, you might have disabled 
cellular access, so always check this menu. 

Check Your Battery Health and Replace It 
If your iPhone’s battery life is particularly poor, it might be time to 
replace it. This is common in devices that are more than two 
years old. However, if you use your phone heavily, you might go 
through a battery quicker than that. 
You can check the battery’s health under Settings > Battery > 
Battery Health. Your device will report its maximum capacity at 
the top of the screen. When your iPhone is brand-new, this is 100 
percent. Below that, you should see a note about your device’s 
“Peak Performance Capability.”

If your battery’s “Maximum Capacity” is around 70 percent, or 
you see a warning about reduced “Peak Performance 
Capability,” it might be time to replace the battery. If your device 
is still under warranty or covered by AppleCare+, contact Apple 
to arrange a free replacement. 
If your device is out of warranty, you can still take your device to 
Apple and get the battery replaced, although this is probably the 
most expensive option. If you have an iPhone X or later, this will 
cost you $69. Earlier models cost $49.  
You can take the device to a third party and have the battery 
replaced for less. The issue is you don’t know how good the 

replacement battery will be. If you’re feeling particularly brave, 
you can  replace your iPhone’s battery yourself. It’s a risky, but 
cost-effective solution. 
RELATED: How Difficult Is It to Replace an iPhone Battery?  

Battery Life Can Suffer After an iOS Upgrade 
If you’ve recently upgraded your iPhone to a new version of iOS, 
you should expect it to consume more power for a day or so 
before things settle down. 
A new version of iOS often requires the contents on an iPhone to 
be re-indexed, so features like Spotlight search work properly. 
The Photos app might also run an analysis on your images to 
identify common objects (like “cat” and “coffee”) so you can 
search for them. 
This often leads to criticism of a new version of iOS for 
devastating iPhone’s battery life when, in fact, it’s just the final 
part of the upgrade process. We recommend giving it a few days 
of real-world usage before jumping to any conclusions. 

Next, Tighten Your iPhone’s Security and Privacy 
Now that you’ve done what you can to limit battery usage, it’s a 
good idea to turn your attention to security and privacy. There 
are some basic steps that will keep your iPhone secure.  
You can also perform an iPhone privacy checkup to ensure your 
data is as private as you want it to be.  
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Tim Brookes posted the following article to howtogeek.com on 
July 14, 2020. bit.ly/30TXAbG. © MakeUseOf. He is Mac and iOS 
editor for MakeUseOf and lives in Melbourne, Australia. 

8 Ways to Make Your Mac Boot Faster 
By Tim Brookes  

Your Mac probably takes longer to go from the login screen to a 
usable state than it does for macOS to cold boot, but it doesn’t 
have to be that way. Here are some ways you can get your Mac 
ready to use in record time.


Use Sleep Instead of Shutting Down 
Shutting down your computer and Sleep mode aren’t the same. 
A shutdown first closes all running processes—including the 
operating system—and then cuts power to your machine. When 
you start it up again, everything has to be loaded into RAM. 
macOS also takes time to boot, and any software that starts with 
your machine has to restart, as well.

Sleep is a much faster process. Depending on whether you have 
a desk- or laptop, Sleep mode works a bit differently. On 
desktops, like the iMac or Mac Pro, RAM is left powered on 
during Sleep mode, while other components are powered off to 
save energy.

When you resume your session, your machine wakes up fast, as 
everything you left in memory is still there and ready to go.


For laptops, the process has an additional safeguard. Memory 
contents are left in RAM, and the RAM stays powered on, but 
your Mac also copies everything stored in RAM to the boot drive. 
If the power is interrupted (that is, you disconnect from power for 
long enough), the memory stored in RAM is lost, but it can be 
restored from the drive when you resume.

You can Sleep your Mac by clicking the Apple logo (the same as 
you would to shut down), and then clicking “Sleep.” You can also 
set your Mac to automatically enter Sleep mode under System 
Preferences > Energy Saver.


Sleeping Your MacBook? Stay Connected to Power 
As outlined above, when you cut the power to your MacBook, 
the contents of the RAM is lost. This means it’ll take a bit longer 
to get back to where you were before, as your machine will need 
to copy data to the RAM. This can take significantly longer on 
older machines—especially those with little free space.

To get around this problem, leave your MacBook connected to 
power whenever possible.


Remove Unnecessary Startup & Login Items 
Sometimes, you have to restart or shut down your Mac. If your 
machine takes a considerable amount of time to move from the 
login screen to a usable desktop, you might want to remove 
any unnecessary start-up items because these slow down your 
machine.
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Head to System Preferences > Users and Groups. With your 
username highlighted, click the “Login Items” tab. You’ll see a list 
of applications that start up every time you log in. Highlight any 
you don’t need, and then click the minus sign (-) to remove them 
from the list.


You can also select the “Hide” checkbox for each item you want 
to start in the background without bothering you.

In addition to login items, you might have some system-wide 
startup items that boot whenever anyone logs in. These are 
stored in a hidden folder. To access it, open a new Finder 
window, click Go > Go to Folder . . . , and then type (or paste): /
Macintosh HD/Library/StartupItems/.

This folder might be empty, but feel free to remove anything you 
don’t want to start when your Mac does.


Maintain a Sensible Buffer of Free Space 
macOS needs room to breathe as part of its normal operation. 
Routine operations, like downloading and unpacking system 
updates, or copying the contents of RAM into drive memory, can 
temporarily take up more space than you might have. When this 
happens, things slow down dramatically.


There’s no magic number for how much space you should try to 
keep free, but around 10 percent of your total drive space is a 
good starting point. When you start seeing macOS warnings 
about your drive reaching capacity, it’s time to start freeing up 
some space.

RELATED: 10 Ways To Free Up Disk Space on Your Mac Hard 
Drive


Disable “Reopen Windows” When Shutting Down 
When you choose to restart or shut down your Mac, you get the 
choice to reopen your windows when you log back in. This is a 
useful feature, but many people can probably do without it.

As long as your apps are closed cleanly (which macOS takes 
care of whenever you power off), you shouldn’t lose any data. For 
example, if you close a Safari window full of open tabs, but 
choose not to reopen them when logging in, your tabs will all still 
be there; you’ll just have to launch Safari manually when you 
return to the desktop.


If you don’t need to see every app and window you had open the 
last time you used your computer, you can disable this option. 
You can toggle it on or off under System Preferences > Users 
and Groups > Login Options; just click the padlock and type your 
admin password to make changes.


Reinstall macOS 
If you haven’t reinstalled macOS for a few years, you might be 
surprised just how fast a squeaky-clean install can be. By 
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removing all third-party software, you can start with a clean slate. 
This is a great way to remove outdated kernel extensions and 
other apps you’ve forgotten about.

First, back up your personal data with Time Machine. Note any 
software or apps you rely on and will need to redownload after 
the process is complete. Now, you can restart in Recovery mode 
and reinstall macOS from scratch.


When you’re done, you can restore your Time Machine backup, 
which copies your personal files back to your Mac.


Still on a Hard Drive? Switch to an SSD 
If your Mac is especially old, you might still have a mechanical 
hard drive. To find out, click the Apple menu, and then click 
“About This Mac.” Click the “Storage” tab and look for “Flash 
Storage” under the drive’s capacity.

If “Flash Storage” isn’t listed, your Mac likely has an older drive. 
In that case, click the “Overview” tab, and then choose “System 
Report.” Select the boot drive under “SATA/SATA Express” and 
look for “Medium Type” in the bottom panel.

If this doesn’t say “Solid State,” your computer has a mechanical 
hard drive. You can massively speed up your computer’s boot 
time, as well as the time it takes for software to launch and file 
transfers to complete, by installing an SSD.


Finally: Consider Automatic Login 
Another way to speed up the time between pressing the power 
button and being able to use your Mac is to streamline the login 
process. If you’re the only person who uses your Mac, you might 
want to enable automatic login under System Preferences > 
Users and Groups > Login Options.

If you’re encrypting your drive with FileVault, this option won’t be 
available. You’ll first have to turn off FileVault under System 
Preferences > Security and Privacy > FileVault, which we don’t 
recommend—especially on a MacBook you take outside your 
home or office.

If you have a Mac desktop in a secure location, and you aren’t 
worried about anyone else using it (or stealing it and examining 
your files), automatic login is an option for you.
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The obvious danger here is, because a password won’t be 
required to log in, anyone can fire up and use your computer. 
Your files, browsing history, any websites you’re logged into, and 
more, are immediately at risk.

A safer option is to enable automatic login with your Apple Watch 
(if you have one). This way, you’ll have to be physically present 
for your machine to log you in automatically.



Mindaugas Balčiauskas & Rokas Laurinavičius posted the 
following article to boredpanda.com on July 23, 2020. bit.ly/
2D4YNVN. They are, respectively, Photo Editor and writer at 
Bored Panda. 

This Online Photo Enhancer Helps 
People See Their Ancestors Clearly And 
Here Are 30 Of The Best Restorations  
By Mindaugas Balčiauskas & Rokas 
Laurinavičius  
MyHeritage is an online genealogy platform that helps people to 
connect with their family histories. Earlier this year, they 

introduced MyHeritage In Color™, a new technology supposed 
to bring old family photos to life through colorization. But On 
June 12, the company took it a step further, introducing a tool 
that enhances photos by bringing blurry faces into sharp focus.


"When combined, MyHeritage In Color™ and the MyHeritage 
Photo Enhancer can reveal your ancestors as you've never seen 
them before," the company wrote on its blog. "The technology 
for enhancing photos was licensed by MyHeritage from the 
creators of the Remini mobile application. They developed 
machine learning technology to enhance photos by upscaling 
(increasing the resolution) the faces that appear in them. This 
produces exceptional results for historical photos, where the 
faces are often small and blurry, but works equally well on new 
color photos too. Enhancement works best on photos that 
feature multiple people, and allows you to go face by face to see 
each one enhanced."


MyHeritage really believes that it's the best technology in the 
world for this kind of work. "No other company has succeeded in 
developing photo enhancement technology of this quality. The 
results are crisp and truly outstanding."


Continue scrolling, check out what the enhancer is capable of 
and tell us in the comments whether you agree with this ballsy 
statement! EDITOR - GO TO THE ARTICLE TO SEE THE 30 
UNBELIEVABLE  RESTORATIONS! 

More info: myheritage.com


36

https://www.howtogeek.com/445119/20-apple-watch-tips-tricks-you-have-to-know/
https://bit.ly/2D4YNVN
https://bit.ly/2D4YNVN
https://blog.myheritage.com/2020/06/myheritage-photo-enhancer-goes-viral-one-million-photos-already-enhanced/
https://www.myheritage.com/photo-enhancer


                 VOLUME 31, NUMBER 8                  MAIN LINE MACINTOSH USERS GROUP                  AUGUST 2020 

Akshay Gangwar posted the following article to beebom.com on 
June 8, 2008. bit.ly/2D2KkJP. © Beebom Media Private Limited. 
He is an Associate Editor at Beebom with a Bachelor of 
Technology in IT and lives in New Delhi.  
EDITOR’S NOTE - I DELETED THE GRAPHICS FOR THE 
APPS BECAUSE THEY WOULD HAVE MADE THE ARTICLE 
TOO LONG. YOU NEED TO GO TO THE VENDOR’S SITE TO 
GET A FULL APPRECIATION OF THE APP. 

12 Best Video Editing Apps for iPhone 
You Can Use 
By Akshay Gangwar 
iPhones  are steadily becoming more powerful, and capable of 
highly intensive tasks. With that, the camera in these 
smartphones has also improved to an extent that we can even 
shoot 4K  videos.  All these capabilities make iPhones highly 
capable of handling both shooting videos, and editing them. In 

fact, the latest iPhone 11 and iPhone 11 Pro Max are powered by 
Apple A13 Bionic chip which is rivaling the performance prowess 
of Intel chips used in our laptops. Today, you can not only shoot 
but edit and publish your videos directly from your iPhone. 
Keeping that in mind, we are listing out 12 best video editing 
apps for iPhone which you an use to produce your own 
professional videos in 2020. 


Best Video Editing Apps for iPhone in 2020 
Considering different tastes, we have picked out a variety of 
video editing apps for iOS. While some are more focused on 
offering expertly-crafted tools for a pro-level video-editing, others 
are primed to simplify the whole video-editing process through a 
ton of eye-catching filters and real-time effects. So, even if 
movie-making isn’t your cup of tea, you can create fascinating 

videos that can get a lot of likes on TikTok or set your Instagram 
profile buzzing. Having said that, let the show begin with the right 
timeline! 


1. LumaFusion 
When it comes to video editing on iPhone, no other app comes 
even close to the feature set that is packed inside LumaFusion. It 
is the only outright paid app on this list and it deserve every cent. 
The app is not only used by YouTubers but even mobile 
journalists and professional video producers who don’t want 
to carry heavy camera gear and editing rig where they go. 

One of the unique selling points of LumaFusion is its UI. The app 
looks really clean with no ads or annoying popups to hamper 
your experience. What I love most about LumaFusion is that it 
not only allows users to edit videos in landscape mode but also 
portrait mode. Not only that, you can easily switch between the 
two modes without any hiccup. This comes helpful as the app  
supports a variety of video  aspect ratios including 
landscape, portrait, square, film, and more. 

Talking about features, LumaFusion supports up to 6 video and 
audio tracks for  for photos, videos, audio, titles and graphics 
with an additional 6 audio tracks  narration, music and sound 
effects. You also get a magnetic timeline which makes it 
really easy to manipulate clips once they are imported. 
There’s dozens of transitions and effects with the ability to layer 
effects. Finally, it also comes with dozens of royalty free music, 
sound effects, and more. If you really need a professional grade 
video editing app for your iPhone, you should definitely buy 
LumaFusion. 


Download LumaFusion from the App Store ($29.99) 


2. iMovie 
iMovie is  a part of Apple’s own suite of products for iOS (and 
macOS), and is a great video editor app for iPhone that you can 
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try. While you may want to use a more powerful editing software 
on your Mac, iMovie is more than capable of handling video 
editing on the iPhone. The app is included with  the newer 
generations of iPhones, and you can use it right out of the box to 
make some awesome videos directly on your iPhone.

With iMovie, you can import your videos, and photos into 
projects, and edit them in  a highly intuitive environment. You 
can slice videos, arrange them around on the timeline, and even 
add transitions (basic ones) to the video. Scrubbing through a 
project in iMovie is  highly intuitive as well: you just drag your 
finger across the screen. 

You can even add filters, and themes to the project. iMovie will 
also let you add text overlays, and filters to individual clips in the 
project. 

All in all, the app is definitely one of the best ways to edit videos 
on your iPhone, and you should definitely check it out. 

Download iMovie from the App Store (Free) 


3. Videoshop 
Videoshop is a powerful video editor for iPhone, that will let you 
perform a plethora of operations on your videos. You can record 
clips directly from within the app, or import them  from your 
camera roll. Once you have done that, you can add text to the 
clip, add narration, merge multiple clips into one, and a lot more. 
You can also add tilt shift to the video, and add transitions 
between multiple clips. The tool is definitely very powerful, and 
you can perform a lot of manipulations on your videos using 
Videoshop. 

Once you’re done with the editing,  the app compiles the video, 
and you can add themes, and filters to the finished video, as 
well as add a title, author name, and much more. The app also 
offers the ability to export the completed video to  Dropbox, 

Photos, or share on platforms like Vimeo, Instagram, YouTube, 
and many more.


4. Splice 
Splice is a video editor from GoPro, the company behind some 
of the world’s best action cameras. You can import your photos 
and videos into the app, to edit them into a movie. The way the 
app works is simple: you just import the videos that you want to 
edit, and mark  the important parts (Hilights, as the app calls 
them) of the video. You can then add music to the video, and 
then the app automatically clips the entire video according to 
the Hilights that you marked. 

You can then crop, add effects and text to the video. You can 
also  change the transitions between two Hilights. Once you’re 
done with the edits, you can share the video with links, or 
directly to popular services such as YouTube, Facebook, etc. You 
can even save the video to your camera roll. The app is a simple, 
yet powerful video editor that you should definitely try out on 
your iPhone. 

Download Splice from the App Store (Free with in-app 
purchases) 


5. InShot Video Editor 
InShot is an easy to use video editor for your iPhone which 
brings tons of features. The app allows you to edit both photos 
and videos and also create video collages. When it comes to 
editing, you will find all the basic editing tools here such as 
cut, trim, delete, merge, adjust video, and more. You can also 
add your own music or select from its own free music options. 
The app is also good for Instagram users as it allows you to edit 
square videos perfect for Instagram. 

The app also comes with lots of sound effects and supports 
voice over layering. There’s also support for stickers, emojis, 
filters, effects, transitions, color correction, and more. One 
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important feature of Inshot Video Editor is that it also allows you 
to rotate and flip videos which comes in really handy in certain 
specific scenarios. Overall, this is a really good video editing app. 
The only flaw of the app that I find annoying is that the free 
version runs ads. If you can handle that, you are going to enjoy 
using this one. 

Download from the App Store (Free, with in-app purchases) 


6. Cameo 
Cameo is another really good video editor app for iPhone, 
developed by the folks over at Vimeo. The app offers very basic 
video editing capabilities, but works really well. The interface is 
clean, and intuitive, and if you just want to perform a couple of 
basic edits on your video, Cameo is the perfect option. The app 
can import photos and videos from the camera roll, and you can 
easily trim them, add music, themes, and more. You can even 
adjust the intensity of the theme applied to the video, to get 
the perfect effect. 

Once you’re done with the editing, you can share the video to 
Vimeo (if you’re logged in to the app), or you can save it to your 
camera roll. The app supports exporting videos in 720p, 
1080p, and 4K resolutions, as well. 

Download Cameo from the App Store (Free) 


7. Quik 
Quik is another iPhone video editor app from GoPro. With Quik, 
you can quickly create good looking videos with just a few 
taps.  The app has the option to import photos and videos 
from  the photo library, or your Facebook, or Instagram account. 
Once you’ve selected the photos and videos you want to edit, 
you get the option to add Hilights to the video clips (just like in 
Splice). However, you get the  options to change the format 
between cinema, and square.  Also, you can change 
the background music for the video, as well add a plethora of 

filters to the video. Quik also has the option to add a title to the 
video. 

 Once you’re done, you can simply save the video, and upload it 
to Instagram, Facebook, etc. You can even directly share it on 
WhatsApp,  Facebook Messenger, etc. Obviously, you can add 
the edited video to your photos library, as well. 

Download Quik from the App Store (Free)


8. KineMaster Video Editor 
KineMaster Video Editor is one of the best iPhone Video editing 
apps that you can use. The app offers professional level editing 
tools and yet makes it easy to start your video editing journey. 
One of the good things about this app is that it supports 
landscape, portrait, and square video formats. So whether 
you are editing your family video, a video for YouTube or for 
Instagram, you can edit your videos using KineMaster. Another 
good thing about this app is that even the free version doesn’t 
show any ads. 

Talking about the editing features, it sports a multi-track 
timeline which means you can add more than one video and 
audio tracks. You can add background music or record voice-
over right there in the app itself. There’s a built-in asset store 
where you can both free and paid music, clip graphics, fonts, 
stickers, transitions, and more to enhance your video. Other 
features include auto audio ducking, speed control for time 
lapse, and keyframe animation among other things. This is a 
feature rich video editing app for iPhone and one of the best 
ones you can find on the App Store. 

Download from the App Store (Free, with in-app purchases) 


9. Magisto 
Magisto is a very simple video editor app.  With this app, you 
don’t get any features such as adding text overlays, tilt shifts, etc 
to your video. However, the charm of this app lies in its 
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simplicity. Within the app, you can import your photos and 
videos, and choose a theme for the video. There are a number 
of themes available, such as dance, among many others. Once 
you’ve done that, you get the option to add music to the video, 
as well as options to decide how long you want the video to be. 

You can even add a title to the video at this point. Once you’re 
done, the app automatically starts making the video, and sends a 
notification when it’s done. You don’t have any extra level of 
control over the video, but that’s exactly what you may need at 
times. 

Download  Magisto from the App Store (Free, with in-app 
purchases) 


10. Enlight Videoleap 
Lightricks’ Enlight has long been a top-notch video editor for iOS 
and certainly one of my favorites. So, I’m not going to miss out 
on this one. What puts this video editor at the forefront is 
the versatility to make all kinds of videos. Therefore, it doesn’t 
matter whether you are willing to craft a light-hearted video with 
plenty of fun elements or a cinematic clip with Hollywood style 
twists, chances are it can fit into your billing.

For those who have a liking for instant effects will find Enlight’s 
library of effects pretty good as they are of a wide variety. Plus, it 
also scores quite well on the filters department which could be a 
big deal for making a video garner a lot of attention on social 
media. Beyond filters, the app also offers the desired flexibility 
to  customize layers  with masking, transformation, and even 
blending modes so that you can craft your movie like a pro. 

Download Enlight Videoleap from the App Store (Free, with in-
app purchases) 


11. Filmmaker Pro 
If you don’t want to settle anything less than the pro-level video 
editing tools, I would recommend you to give a shot to 

Filmmaker Pro. The app is feature-rich and comes with a host of 
professionally-crafted filters and effects so that you can give 
the right look to your clip in the blink of an eye. Aside from high-
quality filters, Filmmaker Pro also shines quite well on the 
customization front. Thus, if you prefer to fine-tune your tools for 
desired precision, it can live up to the task. Another feature worth 
mentioning is that it has got a  solid library of a lot of audio 
tracks and sound effects  which can come in really handy in 
adding the surprise elements to a video. Besides, it also offers 
easy-to-use tools to customize audio tracks. But what has 
appealed me the most towards Filmmaker Pro is an ever-growing 
collection of classy fonts and labels as they play a crucial role 
in making a video become hit among netizens. 

Download Filmmaker Pro from the App Store (Free, with in-app 
purchases) 


12. VivaVideo 
Should you wish to craft attractive videos without getting into the 
complexity of video editing, look no further than VivaVideo. What 
makes it really helpful for newbies is the short tutorial for each 
feature, which makes it much easier to understand how and 
where to use a specific tool. As I prefer to have an  intuitive 
timeline  to edit clips with ease, VivaVideo’s comparatively neat 
timeline hasn’t failed to catch my eyes. The timeline makes it a 
lot easy to add items like text, music, stickers and handle them 
without any hassle. 

Not to mention, the multi-track music feature which allows you 
to add music, sound effect, and even voice-over simultaneously. 
If you like to make the audio stand out, this feature can tickle 
your fancy. For a more dramatic effect, you can also mix videos 
and pics together  so that your creativity can arrest attention 
right away. Overall, VivaVideo is the sort of video editor that can 
attract most users’ creative penchant. 
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Download  VivaVideo from the App Store (Free, with in-app 
purchases) 


Easily Edit Videos with these Video Editor 
Apps for iPhone 
The latest iPhones are quite capable of handling  video editing, 
even if you’re editing 4K videos shot with your phone. You can 
easily use any of these apps to edit  your videos, and get 
the  perfect movie to share with the world. So, have you ever 
wanted to edit videos on your iPhone? If so, what app did you 
use to do it. Also, if you know of any other app that deserves to 
be on this list, do let us know about it in the comments section 
below. 


Cameron Summerson posted the following article to 
howtogeek.com on July 23, 2020. bit.ly/2Pgj257. © IDG 
Consumer & SMB.He is the News Editor at How-To Geek and 
Review Geek, where he's responsible for curating news 
coverage. Cam joined the team in 2017. 

I Switched from LastPass to 1Password 
(and You Should, Too) 
By Cameron Summerson  
I’ve been using LastPass as my primary password manager for 
many years—if I had to guess, I’d say it has to be close to 10 
years now. And over those years, it has let me down, 
disappointed me, and frustrated me on multiple occasions. A few 
weeks ago, I finally made the switch to 1Password. I should’ve 
done it ages ago.

To be clear, there’s nothing glaringly wrong with LastPass—or at 
least that’s what I told myself for multiple years. Sure, the 

Android app doesn’t always auto-fill options and the Chrome 
extension stays logged in literally all the time. The app has 
suffered multiple data breaches over the years, too. But that’s all 
par for the course, right?

Not even close.

I honestly didn’t realize how poor of a password manager 
LastPass is until I used 1Password. The Android autofill issues 
are one thing—a minor annoyance at best—but the poor security 
implementation for an app that’s supposed to store some of your 
most private information is downright inexcusable.


LastPass’ Security Protocols Are Pathetic 
If you have a LastPass account, you already know how this 
works: you install the app or go to the website and log in. Maybe 
you also have two-factor authentication enabled on your account
—good for you. But that’s optional, and if you don’t already know 
that LastPass offers 2FA, then it’s pretty much guaranteed that 
you don’t have it enabled. (How could you enable something you 
weren’t aware of, after all?)

And if you install the Chrome extension, you only have to log in 
once. After that, as long as the computer stays online, you’ll 
never be asked to log in again. At that point, anyone who has 
access to your computer also has access to your passwords. 
That’s a disaster just waiting to happen. You can change this 
behavior in LastPass’ extension settings, but it’s just baffling that 
auto-lock isn’t enabled by default. You should not have to opt in 
to better security, especially in a password manager.

But 1Password does things differently. First of all, it doesn’t just 
force 2FA out of the box, but it sets a “secret key” when you 
create your account. This is a highly complex key that is required 
every time you log in on a new device (note: only on the first log 
in—after the device is confirmed, you can log in with just your 
username and password). The key is automatically generated 
and shared with you in a document when you sign up for 
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1Password. This key is also stored on your trusted devices, so 
it’s easy to keep secure but hard to lose.

That’s a big level up on security for all your passwords. You know 
what else 1Password does that LastPass doesn’t? Auto-lock the 
vault in the Chrome extension by default. Both 1Password and 
LastPass lock the vault after a period of inactivity on mobile, but 
the same doesn’t apply to browser extensions. It’s baffling. (If 
you use LastPass and don’t want to switch, please enable this 
feature Account Options > Extensions Preferences > Log Out 
after this many minutes of inactivity.)


Why isn’t this enabled by default?

Now, LastPass could fix both of these issues pretty easily by 
forcing 2FA and auto-locking the vault by default. But it’s been 
years now and neither of those things have been done. Hard to 
say if or when they ever will. So, it’s time to switch.


1Password Has Never Seen a Data Breach 
Since 2011, LastPass has been involved in five data breaches or 
other security incidents—2011, 2015, 2016, 2017, and 2019. To 
be fair, some of these weren’t major; just exploits that were 
discovered. And in all of those cases, LastPass did a notable job 
of disabling or patching these vulnerabilities. It’s fair to give credit 
where it’s due.

But if you Google “1password data breach” the first option isn’t 
some high-profile leak that 1Password was a part of. It’s a link to 
the 1Password blog about what would happen if the company is 
ever part of a breach, which starts with the words “1Password 
has never been hacked.” If you’re considering a switch, this is 
worth a read. Even if you’re not considering a switch right now, 
it’s worth a read. It might change your mind.


The Android App Is Far More Reliable 
You can search the 1Password vault right from the autofill dialog 
Cam

One of my biggest peeves with LastPass is how utterly unreliable 
the Android app’s autofill option has been—even after Google 
implemented the autofill API, which I hoped would solve these 
issues. But nope.

I’m not sure what the determining factor is here, but sometimes 
the autofill feature works fine on LastPass. Other times it never 
prompts at all. And others, it prompts but says there are no 
saved passwords for that app/site. And there isn’t a way to 
search directly from the autofill prompt.
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Again, 1Password fixes all of those issues. For starters, there 
hasn’t been a single time that it hasn’t offered a prompt on a 
password box. And in the case when it doesn’t associate a 
password from a site with its corresponding app, you can search 
directly from the prompt and assign the password to the site right 
there—it takes just a few taps. After that, the association is 
stored, so logging in the next time will be even easier. LastPass 
doesn’t have anything like that.

Now, to be fair, if you’re an iOS user, you probably haven’t 
experienced any of these issues. iOS password autofill options 
seem to work much more reliably than Android’s, as I haven’t 
experienced any problems with LastPass on iOS. That said, 
1Password works just as well, so you’re not losing anything if 
you make the leap.


Switching Was More Painless Than I Ever 
Expected 
Try watching this video on www.youtube.com, or enable 
JavaScript if it is disabled in your browser.

I have an embarrassing confession: the main reason I didn’t 
switch sooner is that I didn’t want to spend the time to do it. In 
my head, this was going to take hours. That’s actually so 
incorrect I feel stupid just saying it. The switch literally took like 
five minutes. No joke—five.

In fact, 1Password has an excellent guide on doing just that on 
its support site. Ultimately, it boils down to two steps: export 
your LastPass vault, then import it to 1Password. In my 
experience, everything synced across beautifully.

All told, I had 1Password up and running on three phones and 
four computers in about 20 minutes, which includes removing 
LastPass from those devices. I feel ridiculous for waiting so long.

There is one minor catch though. For some reason, there are two 
versions of the 1Password browser extension—one requires the 
desktop app to be installed and the other doesn’t. I recommend 

using the 1PasswordX extension, which works on its own. 
Otherwise, you’ll also need to install the desktop app, which is 
honestly just kind of redundant. As an added bonus, the 
1Password extension has a much lower impact on system 
resources than the LastPass extension (at least in Chrome).

But there’s also the question of pricing. For most people, 
LastPass is free—you can use it on multiple devices without 
paying a dime. If you want to add encrypted file storage to the 
mix, you can do so for $3 a month.


1Password’s plans. 
But 1Password is $3 a month out of the gate or $5 a month for 
your entire family. You know the saying “you get what you pay 
for?” Well, I don’t think it’s more true than it is right here—
1Password is more secure and more convenient than LastPass, 
which more than makes it worth $3 a month.

If you’ve been considering switching from LastPass to 
1Password, I highly recommend it. I wish would’ve done it years 
ago.


AI and Humans 
Deep Skin 
By Kathy Garges 

Invention in artificial intelligence is not yet close to achieving 
equal to that of humans. One reason is that the target has 
moved.  Human touch is much more sensitive than previously 
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thought. And human function is not at the biological apex. Those 
raccoons rattling your garbage cans at night, for example, have 
the world’s superior brains for analyzing touch sensory data in 
darkness.


Progress in this area has also been slow because touch and 
sensitivity require advances in several fields. These include 
materials research, sensors, and integration of this hardware with 
AI software to analyze and act on real time data.  Functional 
touch and sensitivity also have unique needs for heat sensitivity 
and self-healing that are difficult to achieve.


Better robot touch and sensitivity will allow humans to work more 
safely alongside robots and will reduce reliance on AI 
enhancement of human vision in applications like robot-assisted 
surgery. In the new priorities created by the pandemic, it also 
ranks high, potentially reducing medical worker exposure to 
contagious disease in patient care by substituting robot care, or 
at least a robot contact interface for care that is operated by 
nearby human workers. Promising developments have been 
reported in recent months.


A team at ETH Zurich has invented a smart glove that captures 
human hand movements in real time without external cameras or 
sensors and under many lighting conditions. Only mapping in 
two dimensions, it is nevertheless quite useful. Think of the many 
semaphoric two dimensional hand poses: movie screen shadow 
duck, thumb up, hitchhiker’s thumb out, victory sign, peace sign 
— and countless others.


The improvement over previous technology is the result of giving 
the AI neural network initial information about the geometry and 
spatial relationships of the scene that limit parameters for 
machine learning from the glove data, rather than basing 
machine learning on a hypothetical open spatial universe. The 
team released over 1 million samples for data for training 
machine learning to the public domain.


The glove will be developed to translate human hand movement 
to robot or virtual movement. Like other developments in this 
area, however, it also has potential to be adapted for reverse 
operation, translating virtual-world “touch” data as feedback to 
the human glove wearer (in virtual reality games, for example), 
and eventually to more complex human-AI interaction with 
ongoing feedback and action on both levels.


Engineers at the University of Houston are exploring the AI 
possibilities of an exciting super material, indium zinc oxide (IZO). 
It can perform at least 5 different functions: an electron-
conducting semiconductor, a photoconductor in ultraviolet light 
sensors, a variable resistor in a temperature sensor (its electrical 
resistance decreases with higher temperature), a strain resistor in 
a touch sensor (its electrical resistance increases with increased 
physical strain), and a memory material (certain electrical 
voltages break or form material filaments). These functions would 
otherwise require separate devices of complex design that then 
would need to be integrated to function together.


The team made IZO into a flexible patch to attach to a human (a 
human-machine interface or HMI). The patch translates human 
movement to a robot and also receives temperature feedback 
from the robot.  The temperature feedback works by an IZO 
sensor on the robot hand that samples the temperature of the 
environment or an object grasped by the robot. The robot, 
grasping the human’s hand, then generates an electrical voltage 
to stimulate a microheater on the human’s hand to the same 
temperature.


Heat sensing is important for robot touch as it is for human 
touch. A robot needs to protect its surface from heat or cold 
damage, too. For example, when fetching a hot cup of coffee for 
its human boss, temperature sense will prevent the robot’s hand 
from melting and the human’s hand from burning.


South Korean researchers recently reported their invention of an 
orange jelly made mostly of acrylic acid and water that can be 
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3D-printed into any coating or shape, can tell the exact point 
where it is touched, and can self-heal. The researchers tested 
3D-printed rings, finger caps (similar to sewing thimbles), and 
other shapes. Comparison of the intensity at various points of a 
weak electrical field applied to the artificial skin shows the touch 
point.


The material contains positively and negatively charged particles 
that are attracted to each other, promoting self-healing. Rapid 
self-healing of both the material structure and sense function of 
artificial skin are important to avoid interruption of robot function. 
Self-healing by intrinsic or constructed properties of the material, 
without the need for outside intervention or stimulation, is 
preferable.


So far, the self-healing properties of robot skin are far from 
instantaneous. The recent developments in temperature function 
are more promising. Soon, a robot may be greeting you with a 
friendly, warm handshake. And soon medical patients could have 
their foreheads “felt” for elevated body temperature, and receive 
supportive warm hand squeezes, from a robot operated by a 
human friend, family member, or medical professional at a safe, 
but visible distance.
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